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Introduction 

Pico Technology was established in 1991, and quickly became a leader in the field of PC 
oscilloscopes, data loggers, and automotive diagnostic equipment. 

Pico Technology has always been recognized for providing innovative, cost-effective alternatives to 
traditional test equipment and data acquisition products. In doing so, it has made high-quality 
instrumentation affordable. 

The equipment 
Each PicoScope Automotive oscilloscope comes supplied with a base set of tools and components, 
allowing you to take the voltage and current measurements you need to perform a wide range of 
tests. 

The PicoScope unit itself takes the readings from the probes and current clamps that are attached, 
and converts them into signals for your PC to display. It uses industry standard BNC connections, 
enabling the use of a wide variety of accessories, and is connected to the PC/laptop by a USB lead, 
which it also uses to draw power. 

Automotive oscilloscopes 
A PicoScope (sometimes known as a lab scope) turns your laptop or desktop PC into a powerful 
diagnostic tool. Think of it as the X-ray machine of diagnostics, letting you see the changing signals 
inside wires. 

You can purchase a PicoScope on its own, but most people purchase one of our award-winning 
Automotive Diagnostics Kits. These money-saving kits contain everything you need – just add a PC. 

PicoScope Starter Kits are supplied in a cardboard packing box. Other kits are supplied either in a 
tough carry case or with foam trays to fit a tool drawer. 

All tests done with the PicoScope involve very little mechanical intrusion, and remember, with every 
test you do with PicoScope you can: 

• Save the results you capture in a folder (like any PC file) and back them up into our Waveform Library. 
• Share the results with other users (providing a date and time stamp test procedure for future reference) 
• Replay the test results like a video 
• Accurately measure the time taken during each fluctuation 
• Compare results with previously saved tests 
• Measure even the fastest changes in the rise and fall of pressures. 

You can read more about the company and our products on www.picoauto.com 

This book 
This book gives a basic overview and introduction to PicoDiagnostics, PicoScope 6 Automotive, and 
the PicoScope unit you will be using. It will mainly focus on the user interface of the software, but 
has some detailed information about a few of the features. 

For more in-depth information about the different elements mentioned in this book, we recommend 
step 3 of this training course. The book also incorporates the practical tests in focus during the 
training.  
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PicoDiagnostics and PicoScope 

PicoDiagnostics is an automotive fault-finding program for your PicoScope oscilloscope. Along with a 
PicoScope, it turns your PC/laptop into a multifunctional diagnostics tool. It includes a range of in-
built tests that are easy to operate, such as compression tests, battery and alternator tests, and 
cylinder balance. 

This means you do not need to buy expensive extra tools to carry out all the tests you need. 
Connection, wiring, and component faults are easily diagnosed with PicoScope, helping save both 
time and money that could have been wasted replacing component parts that are not faulty. 

It can also be used to view data packets from complex engine management systems and pinpoint 
the root cause of parasitic currents draws that cause flat batteries. 

If you need to go beyond the in-built tests, PicoScope 6 Automotive gives you all the features of an 
advanced oscilloscope, and can be used to diagnose almost any electrical component in any vehicle. 

The software is continually updated, so that you always have access to the newest content and 
features. 

A key point with the PicoScope Automotive software is that the software is free and can be 
downloaded from www.picoauto.com by anyone – with or without a PicoScope oscilloscope. This 
means that anyone can view saved waveforms in the same detail they were captured in. 

Voltage vs time – the benefits 

Scope diagnostics is only for the experts – right? 

This perception could not be further from the truth. While Pico may be used by some of our 
industry’s foremost experts (thanks to its outstanding performance and resolution), it is surprisingly 
intuitive and easy to use for the novice. 

While we may prefer a more secure connection than multimeter probes, there is virtually no 
difference between connecting the meter and the scope. For our scope connection we use back-
pinning probes or breakout leads, to give a better connection, but in truth these are no more 
difficult to use. 

The user friendly software makes it easy to capture, view and analyze waveforms. The waves are 
displayed in a signal view showing voltage over time. This simplifies the analysis and helps you find 
fault without invasive tests and time-consuming engine dismantles. 
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PicoDiagnostics 

Using PicoDiagnostics for the first time 

We have designed PicoDiagnostics to be as easy to use as possible. Once you have followed the 
introductory steps listed below, you will soon become an expert.  

1. Plug in your PicoScope oscilloscope. Windows will recognize it and 
make the necessary changes to allow your computer to work with it. 
Wait until Windows tells you that the device is ready to use.  

 
 

Desktop icon 
 

2. Click on the PicoDiagnostics icon on your Windows desktop. 
 

3. Click on the button for the test you wish to perform. 
 

4. Follow the on-screen Setup Wizards or instructions to connect your 
scope and run the test. 

 
 

 

  

 
PicoDiagnostics Welcome screen 

 

  



6 
 

Notes: 
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Menus 

Menus are the quickest way to get to the main features in PicoDiagnostics. The Menu bar is always 
present at the top of the main window. The list of items in the menu bar may vary depending on 
which test you are running. 

File menu 

Click File on the Menu bar. 

 
 
User Details dialog 

This dialog appears when you select Preferences on the File menu. In it you can enter details about 
your company and add your name for the report. 

Enter all the values you want. 

Click OK to close the dialog and save the changes. 

Click Cancel to close the dialog and discard the changes. 

View menu 

Click View on the Menu bar 

Details 
In this box you can edit the customer and vehicle details for the vehicle you are testing. There is also 
space for entering notes about the test. 

The data in this dialog will be saved with the test and printed on the report. 

Click OK to close the dialog and save the changes. 

Click Cancel to close the dialog and discard the changes. 
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Tests menu 

Click Tests on the Menu bar 

This menu lists all the available tests. Click one of the tests to continue. 

 
 

Options menu 

The Options menu changes depending on which test you are carrying out at the time. 

Help menu 

Click Help on the Menu bar. 

These are the standard Windows options for access to this help file. Note: Show Vibrate Help option 
only appears when within the NVH test. 
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PicoScope 6 Automotive 

PicoScope 6 Automotive is an ever-evolving program, so it is important that you always have the 
latest version of the software installed on your PC. 

Launching PicoScope 6 Automotive on the PC/laptop 

Open the PicoScope Automotive software by clicking on the icon on your Windows desktop. 

 
Desktop Icon 

Introducing the software 

The software is designed to use as much of the PC/laptop display screen as possible to display the 
waveform being captured. 

The display is divided into three sections, the Signal View (green area), the Toolbars (red areas), and 
the Menu bar (blue area). 
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Signal view 

The signal view is split into a fixed 10 by 10 grid. The 10 vertical divisions represent the voltage 
range, while the horizontal ones represent time. The grid is fixed, but the voltage and time 
(timebase) can be varied. The oscilloscope trace is drawn from left to right across the signal view. 

Timebase 

The timebase is, by default, set to 5 milliseconds per division (ms/div), but can be varied in multiples 
of 1, 2, and 5. The minimum and maximum timebases depend on the sampling rate of your 
PicoScope. Our automotive scopes, PicoScope 4225 and PicoScope 4425, have a maximum timebase 
of 5000 s/div. 

There are a lot of timebases to choose from. You can access these by scrolling up and down in the 
drop down menu for time/div. By default, the timebase is set as time per division, but you can 
change it to show the total collection time instead. 

Triggering 

A trigger is a voltage level that, when a signal passes through it, causes the oscilloscope to capture or 
lock on to the waveform, and stabilize it on your display. If you do not set a trigger, the trace may 
not be stable on the screen, and you could miss the signal you are looking for. 

Notes: 
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Main toolbars 

 

 

 Scope mode Switch to a time-based instrument. 

 Auto Setup Selects the best settings to capture the current signal. 

 Home Load user default settings 

 Collection time In time per division (assumes 10 divisions) 

 Horizontal zoom This allows you to zoom in the horizontal direction, 
subject to the capabilities of the device. 

 Number of samples This defines the maximum number of samples across 
the screen; the more samples, the more detailed the 
signal trace (and the larger the saved file) becomes. 

 Waveform Buffer Index Each screen capture in PicoScope 6 Automotive is 
called a waveform. The software can store more than 
one waveform at the time, and the Buffer Navigation 
toolbar keeps count of the number that has been 
captured. The maximum number of buffers is 10 000.  
You can navigate through these buffers either by 
clicking on the double arrows to move backwards and 
forwards or by using the Buffer Overview, which gives a 
thumbnail view. 

 Buffer overview This section shows an overview of multiple buffers for 
browsing and searching. 

 Select You can select items by clicking on them. 

 Hand Click and drag the graph to move it around within the 
view. This moves all channels of data at the same time. 

 Windowed Zoom This button allows you to specify an area of interest by 
drawing a box around it. 

 Zoom in These two buttons allow you to expand a point of 
interest just by clicking on it, and to zoom out again 
afterwards. 
 

 Zoom out 

 
Undo zoom Returns the current view to the previous zoom. 

 Zoom to full view Zoom out fully to view the entire graph. 
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Zoom overview and scrolling 

When the waveform is zoomed in, the Zoom Overview window appears. This area can be resized by 
dragging the corners of the box, and moved by clicking and dragging within it. You can use the hand 
tool to move around a zoomed-in waveform, and to click and drag the main signal view. 

Coupling 

 

Coupling sets up the input circuitry of the oscilloscope. Three kinds of 
coupling are available: 

  
Coupling type Description 
AC Rejects frequencies below 1 Hz, useful for removing DC offset from an AC signal 
DC Accepts all frequencies from DC to the scope’s maximum bandwidth. 
Frequency Enables the built-in frequency counter, only available on some 4000 series 

Automotive oscilloscopes. 

Channel toolbar 

Channel selection 

Multiple channels can be selected. Each one is identified with a different color trace and matching 
axis: 

Channel A Blue 
Channel B Red 
Channel C Green 
Channel D Yellow 
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Voltage range 

 

The voltage ranges are selectable and go up in multiples of 1, 2, and 5: 
e.g. ±100 mV, ±200 mV, ±500 mV, ±1 V. While the timebase can be 
changed from time per division to the total collection time, the voltage 
scale is always set as the full voltage range across all 10 divisions, so 
each division on a ±20 V range represents 4 V. 

 

Lowpass filtering 

Lowpass filtering is useful when you want to eliminate noise from a signal. This is done by rejecting 
the high frequency data from any selected input channel. The filtering control is found in the 
Channel Options menu, which you can access by clicking the Channel Options button for the 
relevant channel. 

 
 

Notes: 
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Menus 

File menu 

You can access the File menu from the menu bar. It allows you to open and view saved files, view 
recent files, change start-up settings and print. 

Save  
This allows you to save the current waveform, all the 
waveforms in the buffer, or a selection of waveforms from the 
buffer. 

Save as 
This allows you to save the current waveform, all the 
waveforms in a buffer, or a selection of waveforms from the 
buffer as a new file. 

 

The following table shows a list of file formats that can be saved or opened in PicoScope 6: 

Format Description 
psdata PicoScope 6 format contains full waveform data and settings 
pssettings PicoScope 6 format contains settings 
csv Stores up to 1 million samples 
txt Stores up to 1 million samples 
bmp Image format 
png Image format 
gif Image format 
Animated GIF Image format over a number of waveforms, showing an animation of all 

the waveforms in a continuous loop (only available when saving all 
waveforms) 

MATLAB MATLAB 4 .mat binary format: an open format with no limitation on the 
number of samples 

jpg Image format 
pdf PDF format. Output file contains a snapshot of the waveform, with no 

borders 
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Waveform Library Browser 
Browse the online library of over 2000 PicoScope waveforms. 
 
Start-up settings 
Loads the pre-defined start-up settings 
 
Print and Print Preview 
Use the Print and Print Preview options to print a paper copy of your waveform and to check how it 
will look on the page beforehand. 
 
Recent Files 
This shows a list of the most recently viewed waveforms, which appear as thumbnails for quick and 
easy viewing. 
 
Exit 
Close the application without saving 
 
Edit menu 

Copy as Image 
This allows you to copy just the signal view, excluding 
measurements and the ruler legend box. 

Copy as Text 
This copies the raw data in text format and can copy up to 1 
million samples per channel, which you can then paste into a 
spreadsheet. 

Copy Entire Window as Image 
This copies the entire PicoScope 6 window, including everything you can see. 

Notes 
A Notes box is added at the bottom of the page. It is visible when printed and is preserved when the 
file is saved. 

Details 
Box to fill out information about vehicle, test, and customer for the report. 
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Views menu 
Add View 
The option to add another scope view or an XY view. 

Rename View 
Give a view a new name 

Close View 
Closes the view added last 

Channels 
Choose which channels to view 

X-Axis 
Choose between time or channel for the x-axis 

Grid Layout 
You can choose how many viewpoints you want on the display, auto will follow 
the amount of views you have, or you can pick a fixed number up to 9. There is 
also a custom button. 

Arrange Grid Layout 
Arranges the various viewports into a grid format. 

Reset View Sizes 
If you have changed the size of some of the views, you can click this button to 
reset them to standard size. 

Move View To 
Move the views between different viewpoints. 

Arrange Views 
Allows you to arrange the various Viewports 

Auto-Arrange Axes 
Automatically adjust the axes for your measurements. 

Reset View Layout 
Reset changed layouts of views to standard layout 

View Properties 
This pane will show you the details for sample interval, sample rate, number of 
samples, channel, range, coupling, signal type, frequency, amplitude, offset, 
capture date and capture time. 
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Measurements menu 
Add Measurements 
Opens the Add measurement box 

Edit Measurement 
Lets you change the measurements settings 

Delete Measurement 
Deletes the applied measurement 

Grid Font Size 
Lets you choose grid font size 

Column Auto-width 
Check box – click on this to resize the measurements grid 
automatically. 

 
Tools menu 

 

Custom Probes 
Select a probe, make a new one, duplicate a probe or import a 
probe. 
 
Math Channels 
Select a math channel, create a math channel, duplicate a 
math channel, or import/export a math channel. 
 
Reference Waveforms 
Select a reference waveform, duplicate a reference waveform 
or import a reference waveform. 
 
Serial Decoding 
Add, edit or delete decoders. 
 
Alarms 
Apply, add, edit, remove or move alarms. 
 
Masks 
Add, clear or save masks. 
 
Macro recorder 
Record and execute common task. 
 
Preferences 
Customize the software. 
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The Automotive menu 
The Automotive menu is at the heart of PicoScope 6 Automotive, 
with over 150 guided tests that can be performed on vehicles.  
 
Show Web Help at the bottom of the Automotive menu disables 
and enables guided tests.  
 
Guided tests are pages on the picoauto.com website, with full 
instructions for carrying out the test, along with some background 
information.  
 
This option affects all the guided tests, so if you clear the check box, 
the web pages will not appear. Web help is enabled by default. 
 
 

Help menu 
User’s Guide opens the help file. 
Online Documentation is a link to Pico Technology’s library of 
automotive case studies, training, videos, and tutorials, while Online 
Forum connects you to our support forum. 
Send Feedback opens a dialog to send us your comments on 
PicoScope 6 Automotive from within the software. 
 
 

 
Check for Updates 
If a web connection is active, you can check the latest version of the software and install it if 
necessary. This menu also gives you the option to stay informed of software released under beta 
testing. 
 

 About PicoScope 6 Automotive  
This contains information about the software  
version you are using, and also information  
read from the connected scope. 
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Notes: 
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Stop/Start 

By default, the Start (green) and Stop (red) buttons are placed on the left hand side on the bottom 
toolbar. These buttons will start and stop the acquisition of data (this can also be done by pressing 
the space bar). The blue highlight on either the red or the green button indicates whether or not the 
scope is capturing. This toolbar can also be placed at the top of the screen. 

 
 

Rulers 

Basic rulers 

Measurements can be achieved using either rulers or automatic measurements. There are two rulers 
for time and two rulers per channel for voltage. The voltage ruler handles are the same color as the 
channel they are associated with, while the time ruler handle is white. The rulers can be used by 
moving the mouse over the ruler handles and dragging. You can move the time rulers left and right, 
and the voltage rulers up and down, at any time. 

As soon as you start to move the first ruler, the ruler legend box appears, showing the ruler’s exact 
position on the time or voltage scale. When you drag the second ruler into place, its position is 
added to the ruler legend box and the difference between the two values is displayed. 

Rotation rulers 

The rotation rulers help to measure the timing of a cyclic waveform on a scope view. Instead of 
measuring relative to the trigger point, as time rulers do, rotation rulers measure relative to the start 
and end of a time interval that you specify. Measurements may be shown in degrees, percent or a 
custom unit as selected by the Ruler Settings box. 
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Ruler legend 

The rotation rulers become more powerful when used in conjunction with time rulers. When both 
types of rulers are used together, the ruler legend displays the position of the time rulers on rotation 
units as well as in time units. If two time rulers are positioned, the legend also shows the rotation 
difference between them. Closing the ruler legend dismisses all rulers, including the rotation rulers. 

 

Notes 

There is also a notes pane that will appear when you click the Notes button on the bottom on the 
screen. This notes pane can be useful during testing if you feel the need to note questions, 
discoveries or other data. These notes will be saved with the waveforms if you choose to save them. 

 
 

  



22 
 

The 20:20 rule 

If you are not sure which settings to use to capture your signal, a timebase of 20 ms/div and a 
voltage range of ±20 V is a good start. These settings are usually good enough to capture a general 
automotive signal, allowing you to refine your settings from there. 

ConnectDetect® 

ConnectDetect is a new feature, only available on the PicoScope 4225 and PicoScope 4425 
automotive scopes. It is a simple way to make sure your test probes are correctly attached to the 
components under test. To start using it, click the ConnectDetect button in PicoScope 6 Automotive. 

Every channel input on your PicoScope has an LED next to it. When ConnectDetect is activated, each 
channel’s LED is either green, to indicate that the test probe is directly connected across a 

component, or red, to indicate that it is not. An icon 
representing the LED is also shown on the PicoScope 
screen. 

 

The illustration on the left shows that ConnectDetect is 
activated on all 4 channels, but that only channels A 
and B are properly connected. 

 

 

Recent files 

This shows a list of the most recently viewed waveforms, which appear as thumbnails for quick and 
easy viewing. 
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Reference waveforms 

A reference waveform is a stored version of an input signal. You can create one by right-clicking on 
the view, selecting the Reference Waveforms command and selecting which channel to copy. It can 
be displayed in a scope or spectrum view in the same way as an input signal, and like an input signal 
it has its own measurement axis, scaling and offset button and color. The reference waveform may 
have fewer samples than the original.  

For more control over Reference Waveforms, use the Reference Waveforms dialog as shown below.  

 

1. Tools > Reference Waveforms. Click this to open the Reference Waveforms dialog, shown 
on the right in the picture above. 

2. Reference Waveforms dialog. This lists all the available input channels and reference 
waveforms. In the example above, input channels A and B are switched on, so they appear in 
the Available section. The Library section is empty to begin with.  

3. Duplicate button. When you select an input channel or reference waveform and click this 
button, the selected item is copied to the Library section.  

4. Library section. This shows all your reference waveforms. Each one has a check box that 
controls whether or not the waveform appears on the display.  When enabled, a reference 
waveform appears in the selected scope or spectrum view. In the example above, the new 
reference waveform (bottom) is a copy of channel A. 

5. Axis control button. Opens an axis scaling dialog (as above) that lets you adjust scale and 
offset for this waveform.  
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Guided tests 

The Automotive menu in PicoScope 6 contains over 150 guided tests and includes example 
waveforms and scope settings. These waveforms were captured using the Automotive Diagnostics 
Kit. 

They cover a variety of component tests, including: 

• Starting and charging circuits 
• Sensors 
• Actuators 
• Ignition 
• Communication networks 
• Advanced tests 
• Pressure sensors 
• Motorcycle-specific 
 

An example waveform within the web help (guided test) topic shows how the signal should appear 
(the signal displayed in PicoScope during the test will vary from one vehicle to the next). This will 
contain all the relevant settings to carry out the test, including correct timebase, voltage range, 
custom probe, and triggering. 

The waveform and settings also open in PicoScope 6 Automotive, whether web help is enabled or 
not. You may need to adjust these settings, as every vehicle is different, but they give a good starting 
point. 

The guided test web help also provides notes on the waveform, to explain the detail of the signal. 
Below these, you will find technical information on the test in question. 

You can then start the test, using the green and red Start and Stop buttons. 
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Waveform library 

With a PicoScope, you can easily view waveforms in the very best way possible. Combine this with 
the Guided Tests and the Waveform Library (see below) and you have some great tools to help 
understand and analyze what you are seeing. 

Pico Technology supplies many reference waveforms both within the Guided Tests and of course in 
the Waveform Library. 

The Waveform Library lets you search for a valuable reference waveform as a comparison for your 
test. 

 
 

Login 

To log in to the Waveform Library, make sure your PicoScope is connected to the computer and that 
you have an internet connection. Click on File > Waveform Library Browser. Your login details will be 
the same as the ones you use for the Pico Technology Automotive Forum. If you do not have an 
account with the Automotive Forum, you can register for free via the link on the Waveform Library 
login page. 

Searching 

You can search for a waveform by using vehicle specific identification or the test condition, by using 
engine specific data, or by selecting channel details or all good/bad/unknown waveforms. 
Multiple search options are available, from just the engine number to channel labels. 

The more details entered the more likely a perfect match will be found.  
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Search results 

The search results are displayed with an image: 

 

Using waveforms 

Every single waveform can be downloaded and used as a preset test. Simply search for a waveform 
by make, model or engine code, load the channel or entire waveform and the scope will be set up to 
run that specific test. 

Saving 

By using a PicoScope Automotive scope, you have access to an ever-increasing collection of user-
generated waveforms through our online Waveform Library. You can use this to share your own 
examples of good and bad waveforms, or to browse the waveforms other people have shared. You 
can also use it as an online backup for your waveform files. 
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Labeling waveforms 

To be able to find a saved waveform with the search function, you need to fill out all the relevant 
information in the vehicle details box before you share the waveform. Remember to select Save and 
Share or Share to upload the waveform to the Waveform Library. You can store waveforms locally 
on your machine as well as in the waveform library (Save and share or Save options). 

Notes: 
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Connections made easy 
Current clamps 
Pico Technology's current clamps are ideal when you need to measure currents without breaking the 
circuit. 

Clips and adaptors 
To make the final connection to the circuit you will often require a clip, probe or adaptor. 

Pico Technology has a wide selection available, ranging from back-pinning probes which enable you 
to access signals through the rear of the wiring loom connectors to several different sizes of croc 
clips each targeted at different size connectors. The  Sprung Hook Probes give a secure connection in 
the smallest space and for those occasions where there is no other access we offer piercing clips that 
enable you to make a secure connection though the wire insulation 

Coil on Plug (COP) and Signal Probe 
The coil-on-plug (COP) and signal probe is the fastest way to check coil-on-plug ignition coils and 
spark plugs. With the new COP ignition systems the ignition coils are connected directly to the spark 
plugs — eliminating the need for the spark plug wires. With no high-voltage spark wires, a COP 
probe is required to be able to pick up the secondary ignition waveform. 

HT Extension lead 
An HT extension lead is a simple accessory that allows you to take accurate secondary ignition 
measurements on COP ignition systems. 

HT extension leads are designed to aid diagnostics on secondary ignition circuits by allowing an HT 
measurement to be made when there is no, or limited, access to any spark plug leads. 
BNC to BNC cable 
3 metre (9 ft 10 in) BNC socket to BNC socket cable with earth clamp for use with the Coil-On-Plug 
Ignition Probe. 

Test leads 
Our premium leads are color-coded so that the color of the lead in the engine bay matches the color 
of the on-screen waveform in PicoScope Automotive – never again will you waste your time 
wondering which lead is which. They are fully screened to minimize noise pickup so you can have 
complete confidence in the signal you are measuring. 

USB 2.0 cable 
A high-quality cable designed to ensure reliable signal and power connections between your PC and 
PicoScope. 

USB 3.0 cable 
A high-quality cable designed to ensure reliable signal and power connections between your PC and 
PicoScope. 

  



29 
 

Notes: 



4-Channel Standard Kit

30

Please take a moment to familiarise yourself with the contents of the PicoScope Automotive 4-Channel 
Standard Kit.

31



4-Channel Standard Kit

30

Please take a moment to familiarise yourself with the contents of the PicoScope Automotive 4-Channel 
Standard Kit.

31
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Practical demonstrations 
and tests 
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Test 1: Camshaft Sensor Evaluation 

You are probably familiar with some form of technical data and, as with all forms of diagnostics, this 
is very important. It is especially important when you use it to identify components for testing with 
an oscilloscope. 

First we must identify the location of the camshaft sensor and then find the signal wire to take our 
reading from. 

 

When you have located the camshaft sensor on your vehicle, your next job is to find the signal wire 
(which you should have identified from your technical data). If you do not know exactly where it is, 
you can find it by a process of elimination. Try all wires and insert a back-pinning probe into the 
reverse of the sensor. 

 

This is an image of a typical camshaft 
sensor with a back-pinning probe in 
place. 
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To run our first test we must start the engine and insert the multimeter 
probe in the back-pinning probe to take a reading. 
 
Record your result on the multimeter screen to the left. 
 
You can of course see that the sensor is active, but is this telling you the 
whole story? 
 

 

Use the back-pinning probe you already inserted, and connect a test lead between the probe and 
the PicoScope. 

 

Note: You can ensure that the PicoScope is out of the engine bay and away from moving parts by 
using an S-hook as illustrated. 

Start the engine to capture the signal. 

Press the start button on your PicoScope Automotive software (or use the space bar). When you 
have a few buffers of data you stop capturing and turn the engine off. 

You will see a very distinct difference between this data and the data you collected with the 
multimeter. PicoScope will display a very clear off-on-off-on signal. 
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Record your signal here. Remember to fill out both the voltage (vertical) and timebase (horizontal) 
scaling for your records. 

Use your rulers to record the time between 2 points and the difference between minimum and 
maximum voltage. 

The ruler measurements should be displayed in this box on the screen: 

 

Top tip: You can use the zoom function to make sure you take really accurate measurements with 
PicoScope. 

Note: While we have shown a Hall Effect camshaft sensor, which is the most common one, the 
following examples are of differing cam shaft sensors with their likely signal. 
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Hall Effect Sensor 
The characteristic of a good Hall Effect 
waveform is clean, sharp switching. As with all 
Hall units, it has three electrical connections.  

 

 

 

 

 
 

Inductive Camshaft Sensor 

The characteristic of a good inductive camshaft 
sensor waveform is a sine wave that increases 
in magnitude as the engine speed is increased. 
It usually provides one signal per 720 of 
crankshaft rotation (360 of camshaft rotation). 
The voltage will be approximately 0.5 volts 
peak to peak while the engine is cranking, rising 
to around 2.5 volts peak to peak at idle, 
illustrated in the example. 

 
 
 

AC excited Camshaft sensor 

This type of sensor is used on some of the 
GM/Vauxhall/Opel ECOTEC engines. 

This Cylinder Identification (CID) sensor differs 
in operation from the other inductive sensors, 
by having an Alternating Current (AC) voltage 
supply to the CID sensor. The Electronic Control 
Module (ECM) supplies a high frequency of 100 
to 150 kHz (100,000 to 150,000 cycles per 
second) to an exciter coil that is located close 
to a rotating disk. 
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To understand if your Camshaft sensor is working correctly, it 
is helpful to use a reference waveform. You can find one in 
the Waveform Library. 
 
Remember that you need to: 
 

• Have PicoScope connected 
• Have a login for our Forum group 
• Be online 

 

 

 

 

Finding a known good waveform is critical in understanding if your sensor is working correctly. 

Watch out for this symptom as it may be found in faulty sensors: 

 

A voltage spike on a usually clean, crisp waveform is a sign that there might be a wiring loom issue. 

Wiggle the surrounding looms to see if you can recreate a spike to locate the issue. 
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Be careful though. This is an 

example where you might think 

you can see a voltage spike. 

 

 

Use the zoom and notice the 

frequency of this signal (this is a 

3 cylinder VW Polo). 

 

With the incredible zoom power of 

PicoScope, you can now see that 

this spike actually is the injectors 

being picked up through the 

camshaft sensor, which is perfectly 

normal.  
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Test 2: Diesel Injector Testing 

Even though you might think it is easy to find the injectors, it is still advisable to use technical data to 
identify the signal wire. If you do not have technical data, this can also be done by a process of 
elimination. 

 

Use the 20 A / 60 A current clamp. Select the 20 A range and turn the clamp on. Press the zero 
button before you connect the clamp to the circuit.  

Place the current clamp on the fuel injector's supply wire: 
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If access is difficult, you might have to pull back some of the loom's outer shielding to have sufficient 
room to connect the clamp around the signal wire. It would, however, be even better to use a 
breakout cable designed to work with the component’s connection. 

Start the engine to capture the signal. 

Press the Start button on your PicoScope Automotive software (or use the space bar). When you 
have a few buffers of data, stop capturing and turn the engine off.  

TOP TIP: You can stabiliZe the injector signal on your screen by adding a trigger to your signal. 

 

Start using the Auto function, and move the trigger inside the waveform to stabilize the signal on the 
screen. 

 

This is especially usefull when you want to compare and align multiple injectors on the same screen. 
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This example is a Bosch injector at idle. The waveform shows the three distinctive points of injection. 

 

Record your signal here. Remember to fill out both the voltage (vertical) and timebase (horizontal) 
scaling for your records. 
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Use the following reference guide to help identify the type of injector you have captured. 

Bosch Common Rail Diesel Injector: 

 

There are three distinctive points of injection, the first pulse being the pre-injection phase, the 
second the main injection phase and the third phase called the post injection phase. It is mainly 
concerned with controlling the exhaust emissions.  

Remember, as the throttle is opened and the engine is accelerated, the main injection pulse expands 
in a similar way to a petrol injector. 

When the throttle is released, the 'main' injection pulse disappears until the engine returns to just 
above idle. 

Bosch CDi 3 injector: 

The waveform in this illustration shows pre- and main stages of injection. The traces will vary 
depending on engine load and speed. 
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Delphi Injector at idle: 

This illustration has two pre-injection phases before the main injection phase at engine idle speed. 

Piezo Injector at idle: 

In this illustration, the first two injector phases are pre-injection and the third is the main injection 
phase. The positive signals are the injector 'open' commands and the negative signals are the 
injector 'close' commands. 
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VW PD Injector:  

This system is referred to by the Volkswagen Audi Group as Pumpe-Düse (PD). 

Channel A shows the injector current. At the point of injection the current rises from zero to around 
15 amps. There is a brief interruption before it continues to rise to just over 17.5 amps. The injection 
current remains high for a short period of time, before it is reduced to about 11 amps and enters a 
multi-pulsing phase. 

Channel B shows the injector live circuit. It is important to note that the injectors are live switched; 
at the start point of injection the normal battery supply voltage is shown at around 14 V. The supply 
voltage is modulated to create the injection phases throughout the injector duration of around 2 ms. 

Channel C shows the injector earth circuit. At the end of the injection period the voltage in the 
injector's electromagnetic windings collapses and this induced voltage can be seen rising to around 
50 volts. 
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Diesel injector EuroCargo 

High pressure diesel generated by the high pressure diesel pump is fed directly to the common rail 
and into the injector assemblies.  
The pressure remains equal throughout the injector body until the solenoid or piezo crystal is 
energized by the engine control unit. 
 
Upon receiving the energize signal, a control plunger within the injector will lift from its seat, so 
allowing highly atomized diesel to be injected into the cylinder via the injector nozzle. 
De-energizing of the injector solenoid, or piezo crystal, results in closure of the control plunger 
assembly, and so increases the pressure acting upon the nozzle which will close under the influence 
of the high-pressure diesel and internal spring pressure. 

 
 
High-pressure heavy-duty diesel common rail system allows engine manufacturers to combine the 
benefits of high pressure and fully flexible injection for optimized combustion across the engine 
speed. 
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Identifying faulty injectors 

Using the current clamp to measure current flow through the diesel injector, we can monitor the 
efficiency and operation of the injector through all operational stages. 

Comparing the current waveform from each injector using the reference waveform feature will 
reveal anomalies between each injector. 

The current flows through each injector should be near mirror images of one another. The presence 
of spikes, reduced peak current, delayed current ramping and poor decay that are specific to one 
injector highlight pending injector failure. 
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Test 3: Testing Ignition Coil Packs  

You may be familiar with finding the location of the coil packs, but you should note that this method 
is for testing single coil packs only. To test a multiple coil pack, you would need to remove the whole 
unit and use our HT extension leads to capture the signal. 

 
Testing with our COP Probe could not be easier. Connect the end with the ground clip of the BNC 
cable, with the ground clip to the scope’s channel A input, and the other end to the COP probe as 

shown. Connect the ground clip to a reliable ground point 
on the engine block. 

With the engine running, place the paddle end of the COP 
Probe on the coil pack to start capturing your coil signal. 

 

You will see a really clear waveform, 
showing the entire ignition sequence 
within the coil pack. We would 
expect it to look something like the 
one to the right. 

TOP TIP: Sometimes the signal will appear inverted. You can rectify this by opening the probe menu, 
choose the Secondary Ignition Probe (inverted) from the channel drop-down menu, and recapture 
your waveform. The waveform will now be the correct way up. 
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There are a few events happening in this waveform, and it is worth you making yourself familiar with 
them, in order to identify a fault in a coil Pack 

The secondary waveform shows the length of time required to jump the plug gap as the HT flows 
across the spark plug's electrode after the initial peak of voltage. This time is referred to as either 
the burn time or the spark duration. In the illustration, the horizontal voltage line in the centre of 
the oscilloscope is at a fairly constant voltage, but then it drops sharply into what is referred to as 
the coil oscillation period. 

 

The coil oscillation period should display at least 4 peaks (including upper and lower). A loss of peaks 
indicates that the coil needs substituting. 

The period between the coil oscillation and the next drop down is when the coil is at rest and there 
is no voltage in the coil's secondary circuit. The drop down is referred to as the 'negative polarity 
peak', and produces a small oscillation in the opposite direction to the plug’s firing voltage. This is 
due to the initial switching on of the coil's primary current. The voltage within the coil is only 
released at the correct point of ignition when the HT spark ignites the air/fuel mixture. 

The plug firing voltage is the voltage required to jump the gap at the plug's electrode, commonly 
known as the 'plug kV'. 

Having now captured a coil pack waveform, notice how easy it is to compare different coil packs with 
the coil probe using the reference waveform function. 
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We have captured two waveforms. There 
may appear to be subtle differences 
between these two waveforms. If you use 
the zoom function, it is easy to check if 
the key operation of this component is 
working correctly 

• Drop Down is in alignment 
• The plug firing is on time  
• And the coil oscillations are above four  
peaks in both cases. 

 

 

It would be easy to quickly test all four of 
your engine’s coil packs to understand if 
you have a faulty unit. 

 

 

 

 

 

 

 

 

 

Identify the issue with the coil pack shown 
in the blue waveform 
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Test 4: Relative Compression / Cranking 

This is an essential indicative test to discover if you have any cylinder compression issues. 

Connect: First you must connect the 2000 A 
Current Clamp around the battery+ cable. Make 
sure that the orientation of the clamp is correct, 
with respect to the current flowing away from the 
battery. 
 

Run: To run the test you must set the timebase to 
200 ms per division, start capturing data and then 
start the vehicle’s engine. 

 

The purpose of this waveform is twofold: 

• You can measure the amperage required to crank the engine 
• You can evaluate the relative compressions 

 
The amperage required to crank the engine will depend on several factors, including: the capacity of 
the engine, the number of cylinders, the viscosity of the oil, the condition of the starter motor, the 
condition of the starter motor's wiring circuit, and the compressions in the cylinders. 
 
The current for a typical 4 cylinder petrol engine is in the region of 80 to 200 amps. In the waveform 
above, the initial peak of current (approximately 460 A) is the current required to overcome the 
initial friction and inertia to rotate the engine. Once the engine is rotating, the current drops. It is 
also worth mentioning the small step before the initial peak, which is caused by the switching of the 
starter solenoid. 
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The compressions can be compared against each other by monitoring the current required to push 
each cylinder up on its compression stroke. The better the compression, the higher the current 
demand, and vice versa. It is therefore important that the current draws on all cylinders are equal. 
 

 

Zoom and rulers can help 
evaluate this, although a 
drop in cylinder 
compression is often quite 
obvious. 

 

 

 

 
 
 
If the waveform confirms that a cylinder is losing compression, further testing with a low amp 
current clamp, connected to an injector or ignition coil, will help to identify the offending cylinder. 
 

 
 

This waveform shows an 
engine with a loss of 
compression in one cylinder. 
Note the missing tooth in 
the sawtooth pattern.  
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Test 5: Battery, Alternator and Starting Test using PicoDiagnostics 

This is a powerful battery, alternator and starting test using your PicoScope. To start the test you 
must open the PicoDiagnostics software. 
 

 

The PicoDiagnostics software is downloaded for free alongside our PicoScope Automotive software. 

This software can also be used to test compression and cylinder balance, and with additional 
hardware purchased, you can do prop shaft balancing, and noise, vibration and harshness testing. 
 

 

 

 

 

 

 

 

Run the battery test by following the in guide in PicoDiagnostics. The connections are very easy to 
make. 

Connect BNC cable A from Channel A of the 
PicoScope to the battery +, and to the ground 
point on the vehicle. 

Then connect the 2000 A current clamp to 
PicoScope and position it around the starter 
motor feed cable.   

Make sure that the orientation of the clamp is 
correct, with respect to the current flowing 
away from the battery. 
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Follow the setup wizard in the PicoDiagnostics software to run the test. Register the battery details 
and test conditions to run the test. 

Top Tip: Remember to put the correct data in the drop-down boxes (temperature, type of battery 
and its specifications: CCA, EN, DIN) 

 

When this is completed you can start the software and the engine to capture the data. 

 

The test result is displayed in a simple traffic light system, and covers all the starting and charging 
components. The result can be printed out on a report for your customer. 

The report can be customized with your workshop details and logo, as well as your customer’s 
information. 
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